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Setting Up Outlook Stationery

Introduction
Overview
Many businesses want to present the right image when contacting their customers by email, and the
possibility for Microsoft Outlook ® and Microsoft Outlook Express ® to send either Rich Text or
HTML format e-mails are now more popular than using basic Text format.
Microsoft Outlook ® allows the use of Outlook Stationery and Outlook Signatures to create a
personalised "look" for e-mails, however often these can have a rather basic and even "twee"
appearance, and in their basic form are not particularly suitable for corporate use.

About This Document
We are assuming you already know a little about setting up email Signatures in Microsoft Outlook.
Instead this document will concentrate on showing you a method to add a Header in a template.
This document intends to explain two things:1. How to setup and implement Outlook Stationery Templates in general.
2. How to use a CSS technique to create an email Header section as distinct from the usual Signature/
Footer method.
CSS (Cascading Style Sheets) is a method used in website HTML programming to create "styles" which affect the
appearance of elements on a web page. Most email software nowadays composes and displays email messages using
HTML (Hyper Text Markup Language).

Often businesses may want to make their emails appear like their corporate headed letter paper,
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including logo etc, at the head of the email.
Unfortunately the basic Outlook Stationery templates do not normally allow for headers. At least not
without a little work.
This document explains how you can setup a stationery template for your e-mails to contain both a
corporate header and footer, and be able to tab into the email body and start typing your message
without thinking about it, as in the example below:-

Disadvantage of the Header
Let's be up-front with you from the start.
The main disadvantage with the Header method explained in this document is that the Header will
always be right at the very top of the email, even when the recipient replies to you or forwards the
email to anyone else. This might give the impression that your original email is from your company
even when another person/company replies or forwards it.
This is simply due to the way that the graphic is used in the HTML Template, and not a lot can be
done about this without incurring some of the other problems explained later.
If you can put up with this small issue, and think it might be suitable for your situation, then try out the
method described in this document.
If it is not acceptable, you will have to go back to putting your company logo graphic into the Signature
section as standard, and forego the Header.
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But at least you will have learned in general how to setup Outlook HTML Stationery (you will just
ignore the section that explains how to insert a Background Image and use CSS Code to position the
Header graphic and prevent it tiling).
The method described here is not perfect.
Remember that it is a workaround to the shortcomings of Outlook HTML stationery.
But it is relatively easy to implement - and it's FREE!
If you want perfectly formatted email templates that work in all situations, even when people reply to
you, or forward your emails, you will instead have to research and pay for some software, or Outlook
"plug-in" to do the job for you! Try a Google search for "outlook mail signature manager" or "email
signature management".
You might also be interested in the products from www.symprex.com (lookup Mail Signature Manager)
and www.mapilab.com (lookup Live Signatures and Quick Templates), but you will have to evaluate
them yourself as we have not tried these products, nor do we know whether they are capable of
producing Corporate Headed email templates.
Another possibility is to create an email, lay it out as you require, then save it as an Office Template (.
oft) file, but this would really only be suitable for one-off messages because using the File->New>Choose Form... option, then locating the saved template every time for new messages would
become tiresome.
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Enabling Outlook Stationery
To use Outlook Stationery you must set your email messages to be sent in HTML format.
Note: People who you send emails to will use many different types of email software, and may not
necessarily be able to view HTML emails (or even choose not to), or they might even turn off
displaying of graphics. Therefore you cannot guarantee that people will see your email logo as you
intend it to appear.
You should keep your graphical elements (e.g. header logo) to a minimum, both in quantity (number of
images) and size (you should optimize your graphic images to reduce their size), because this all adds
extra overhead to the overall size of the emails you send, and any Sent copies you store.
That being said, you probably know that the majority of your customer base uses the Microsoft
standard office email software, such as Outlook Express or Outlook 2000, Outlook 2003, etc, and
they should therefore be able to see your corporate header correctly.
In Outlook go to Tools, Options

Then select the Mail Format tab.
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You must set the Send in this message format: to HTML. This then allows you to choose or create a
Stationery template using the Stationery Picker.
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The Stationery Picker looks like this.....
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Clicking Edit allows you to see more info about the template, or modify it by adding your own text/
graphics to act as a footer.
In the example below (one of the standard Microsoft templates provided) two graphics are used; one is
a light colour acting as a suitable background for the whole of the message (this will show behind any
text you type, so it must be light enough not to distract from the actual email message); the second is a
more obvious leaf motif with a black border which has been inserted into the stationery, and would
appear at the bottom of the email message.
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Shortcomings of Templates
Outlook Stationery templates are very simple. In their basic form they pose some problems:· Templates do not normally allow Headers to be created in the standard Outlook Stationery Picker
template designer - it is a very simple tool, offering very basic functions only. It is designed to add a
simple Footer and, if required, a tiled (repeated) background image.
· When writing new emails, Signatures get inserted before any text/graphics added in a Template
(although confusingly Outlook 2003 seems to have changed this behaviour, putting Signatures
after Template content, which means for Outlook 2003 you may have to include company contact
details and information into Signatures).
So, if you add text and graphics straight into the Stationery Picker template designer (where you
can type text or right-click and choose Insert Image), then when you create a new email, Outlook
inserts your Signature above any items in the template.
See the screenshot below which demonstrates what happens if you add a graphic intended as a
Header, then some Footer info.
[Note: If you don't like the problem described earlier in the Disadvantage of the Header section in
the Introduction, when the Header appears at the top of Replies/Forwards, you would normally use
Signatures only, to add a small company logo graphic as part of your signature, i.e. not use
Stationery Templates at all].
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Instead of adding your header graphic directly into the main body of the template, you can add it as
a Background to your message, but....
· ...unfortunately Background graphics get repeated all the way down the page, just making the
message look a mess. It's fine if the background is the kind of graphic designed to tile and cover the
rear of the message, but for a corporate logo which we want to act as a header graphic it just
doesn't work - unless we can do something clever!
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Shortcomings of Signatures
Signatures can be set up and used to provide a personal sign-off and contact details, but they are
designed to add information at the tail end of the email.
Signatures are edited by going to Tools > Options..., select the Mail Format tab, then click the
Signatures button.
· Normally a Signature will only be used to contain the senders name and job title, while the
company information is usually put in the Stationery Template.
· A stationery template can be used to add the company name and contact details. Optionally
you might also insert a small company logo just before the company name, or at the end of the
template.
You could add your text and logo for a header into a Signature, but you would find that every time you
write an email you would have to re-position your cursor after the header before starting to type the
main body of your email message.
For business use, where you might be creating many emails every day, having to remember to
reposition your cursor after the header graphic before typing in each and every email would be very
frustrating. You just want to tab into the body of the message after entering the Recipient and Subject,
and start typing!
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Explanation of what needs to be done
So lets recap our requirements:· Corporate logo (and text if required) to be displayed once, at top centre of emails, as a header.
· Each individual to be able to set up their own personal Signature (free of any general company
information).
· Be able to simply "tab" into the message body and start typing immediately without manually
repositioning the cursor.
· Corporate footer included at tail-end of the email, together with email and website hyperlinks.
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What needs to be done
So how do we achieve it?
The following steps can probably be made quicker/easier and enhancements can be made to the
layout of your template if you use some HTML editing software, a graphics design software package,
and have some knowledge of HTML (Hyper Text Markup Language) and CSS (Cascading Style
Sheets), although this document will explain the important aspects in a moment.
The main steps are outlined below. What else you do to improve your template and its layout is entirely
up to you, and your own level of experience!
1. Use a graphics design package (e.g. MS Paint, Paintshop Pro, Photoshop, Fireworks, Corel Draw,
basically whatever you are familiar with) to create a single graphic containing the corporate logo plus
any textual elements you want included in the header, i.e. any other text, such as phone, fax or
email must also be part of the graphic (although you will likely put that stuff in the footer). This is
because, in order to work around the previously explained shortcomings of Outlook Stationery, we
have to add this header graphic as the background image in the template, but you can only specify
one image to use as a background. Therefore you must put everything into a single image.
This is our GIF format header image (we called it OPSISEmailHeader.gif):-
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After creating your graphic, make sure you save a copy of it as either a compressed .JPG or .GIF
format file to use in the email template. These are standard formats for sending in emails, and can
be compressed to keep their size to the minimum (foregoing some image quality). Other formats will
probably not be displayed, or bloat the size of the email considerably.
2. Copy the newly created image into the Stationery folder relevant to your Windows login. This is
where the Stationery Picker stores your own personalized templates. In due course we will move it
to a more central location, but for the time being the folder where you need to place the new image
should be:C:\Documents and Settings\<your-login-name>\Application Data\Microsoft\Stationery

Note: If you decide to include any other graphics (say in the footer of the template), they will also
need to be copied into the Stationery folder, otherwise Outlook will be unable to include them in the
email, resulting in missing graphics from your emails.
3. We create a new Stationery Template using the Stationery Picker. Click New.

4. Enter a name for the new stationery template, e.g. using your Company name, and select the Start
with a blank stationery option. Click Next.
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5. The blank template screen will show.....

6. In the Preview section of the screen enter the basic footer information you want to appear (keep it
simple in this screen, you can enhance it later by using your favourite HTML editor). Next select the
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Picture radio button.

7. After ticking the Picture radio button, click the Browse button to locate the Stationery folder where
you stored your header image:-
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8. Then select and accept the graphic:-

9. Back in the Stationery Picker screen you can see the name of the image you selected for the
background. Note that currently the image is shown "tiled", and so is repeated in the template
background. We will correct this in a moment.
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10.Click OK.
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11.Right-click in the main Stationery Picker Preview area and choose View Source.
Important: You must right-click and View Source while in the main Stationery Picker Preview area
(not in the Edit Stationery screen Preview area you were viewing in step 9 above) because the Edit
mode puts a lock on the template, and any changes you are about to make to the source code of
the template would not get saved. Just bear this in mind if you use View Source to make any
refinements, so as not to get confused! You can View Source from either Preview area, but you
can only Save changes when in the main Stationery Picker. Remember that we are using the
Stationery Picker in a non-standard way!
View Source will open Notepad and show the actual HTML source code that has been generated for
the template:-

12.Now we need to add some extra code of our own. This will use some CSS code to define the Style
for the message BODY (including the background image), which is as follows:-
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<STYLE type=text/css> body {
background-repeat: no-repeat;
background-position: center 5px;
margin-top: 100px;
margin-right: 0px;
margin-bottom: 0px;
margin-left: 10px;
}
</STYLE>

This will be explained in more detail shortly, but for the time being you need to paste this code
snippet within the HEAD section of the template source code so that it appears like this:-

You should also remove the long path from the background header graphics file name, so that it
becomes for example, just
<BODY style="BACKGROUND-COLOR: #ffffff" bgColor=#ffffff background="OPSISEmailHeader.
gif">
(This means we can move the template and its graphic to the central Stationery area on this
computer and any other PC's in the business that also need to make use of the template).
13.Save the contents of the file, and you will notice that the Preview Area will update to look like this
(notice the header image is no longer repeating in the background, and it is centred in the window,
although this window is too narrow for it!):-
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14.Click OK to accept all the changes and make the new template active. You should now be able to
test it by creating a new Email message in Outlook, and it should use the new Stationery.
15.Now make refinements to the appearance of the footer (see Tidying the Footer section).
16.If all seems well the next step is to move the new template and your header graphic into the central
Stationery area on your computer. Go to the folder:C:\Documents and Settings\<your-login-name>\Application Data\Microsoft\Stationery

You should find a .htm file named according to the name you entered for the new Stationery, e.g.
CompanyName.htm
Copy both this template and the header graphic from the above folder to the proper central area on
this computer:C:\Program Files\Common Files\Microsoft Shared\Stationery

The new template will now be available for any other users who log into this computer.
17.Finally copy the same files to the central area on any other computers in the business that require
this template, and then enable Stationery in Outlook on those PC's as outlined earlier and select
your new template.
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Explaining the CSS Code
The CSS code we inserted was as follows:<STYLE type=text/css> body {
background-repeat: no-repeat;
background-position: center 5px;
margin-top: 100px;
margin-right: 0px;
margin-bottom: 0px;
margin-left: 10px;
}
</STYLE>

In setting all this up we actually used an HTML Editor software (Dreamweaver) which was capable of
creating the required CSS code in the template .htm file. This makes things easier, but the following
description provides enough information for you to manually edit the various parameters.
<STYLE type=text/css> body {

The above line starts the redefinition of the "style" applied to the BODY section of the HTML
used for the email message.
background-repeat: no-repeat;

the above line tells the background image not to repeat throughout the message
body
background-position: center 5px;

the above line positions the background image in the centre, and 5 pixels down from
the beginning of the body, this gives a nice margin for the graphic without it being hard up at the top
edge of the message. You can of course change these values to be "left" or "right", or adjust the 5px
value according to your requirements
margin-top: 100px;

the above line sets a top margin for the body content, e.g. any text entered into the
email message. This is set quite large at 100 pixels to ensure the text you type in emails starts nicely
below the header graphic. In our case the OPSISEmailHeader.gif graphic is 77 pixels high, and we
have already given a 5 pixel top margin above the header graphic, so as a minimum top margin we
require 82 pixels (77+5). Setting 100 brings the text a further 18 pixels below the header graphic. You
should change the 100px value to suit the size of your header graphic.
margin-right: 0px;
margin-bottom: 0px;

the above 2 lines were set to give no bottom or right margins in the body area, as it
wasn't deemed necessary. Change these to suit if you want a bottom or right hand margin
margin-left: 10px;

likewise a 10px left margin gives a neat look by bringing the text of the message in
slightly. Adjust to suit.
}
</STYLE>

the above two lines just close off the re-styling of the BODY.
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Note regarding Stationery Templates vs Signatures:
MS Outlook allows several Signatures to be created.
In later versions of MS Outlook, e.g. Outlook 2003, some changes have been made to allow a
different Signature to be selected for New messages, from the Signature selected for Replies/
Forwards.
At first, this seems like it could be a possible solution for the Disadvantage of the Header described
right at the start of this document, i.e. use a Signature as opposed to a Stationery Template to hold
the header graphic for New messages, and use a different "short" signature for Replies and
Forwards.
This WILL give a viable solution if you insert the header graphic directly into the New messages
Signature (i.e. not as a background image using the CSS method), but unfortunately this then has the
disadvantage that when you tab into the email to start typing your message, your cursor is not
positioned correctly, and you would have to move the cursor in between the header graphic and the
senders sign-off name. Also Outlook, in its ultimate wisdom, inserts a couple of spacing lines before
the signature, thus giving some blank space before your header graphic (because it assumes, under
normal circumstances, that you want to type before your Signature). This spoils the layout of the email
from a Header point of view, which you would want to be at the very top of the message.
So why not use the CSS code in a Signature to position our Header graphic, and set the
Template to <none> so its not using a Template at all?
Well, unfortunately Signatures do not work in the same way as Stationery Templates, and inserting
the <STYLE>...</STYLE> tag into a Signature using a similar method to that described in the previous
section, will not work. A Signature does not insert any information held in the <HEAD> section of its
HTML. It might look as though it has a <HEAD> section if you use the Signature editor, and you then
use the Advanced Editor mode to view the code for the signature, but Signature <HEAD> information
is not used when creating a new email message.
For those of you who understand CSS and like to experiment, you might also be tempted to try a
slightly different approach to take advantage of a non-standards compliant situation with the rendering
of CSS in Microsoft's HTML engine, whereby if you insert the <STYLE> section into the <BODY> of
the Signature instead, this will appear as though it is working initially because MS Outlook will render
it. The problem with this is that people you send emails to who use different email packages, or
Internet browsers to read/view their emails, will not see the header graphic because other HTML
engines comply properly with HTML standards - the rule is that <STYLE> must be in the <HEAD>, and
it is invalid HTML code otherwise.
Neither does Outlook use anything specified within the actual <BODY> tag in Signatures (it does
from Stationery Templates obviously in order to make a background graphic appear), otherwise we
could try using a CSS "inline-style" as part of the BODY tag, to provide the necessary information for
the background image. But then we are adopting methods even further from what Outlook expects,
and it will not "encode" the header graphic for inclusion in the email as an attachment.
So you can probably see now that trying to implement a "Letterhead" style of Email with a Header
graphic, is in fact quite a tricky thing to do in MS Outlook.
We have tried several different approaches, and presented the best solution.
Hopefully you now have a greater understanding of how this all works in MS Outlook, and perhaps see
why the usual way of creating Outlook stationery/signatures, is with a simple sign-off, contact details
and small company logo, all at the bottom of the message, without any fancy letterhead style header.

1.6

Tidying the Footer
The footer entered in the setting up example was very basic, whereas the footer configured in our real
OPSIS template used some further HTML tweaking to provide the required fonts, boldening, centering,
etc.
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This was achieved by further editing of the .htm template file using a standard HTML Editor software
to put the footer section into a Table and apply various attributes to make it look neater.
This screenshot shows a work screen in an HTML Editor called Macromedia Dreamweaver which is
being used to improve the layout of the footer.

1.7

Tidying the Signature
Currently most staff within your business probably use a Signature which includes all their contact
details; possibly the company logo, address, telephone numbers, and so forth.
This is probably most of the information you now have setup in your Stationery template Footer.
So each user will need to create a new short version of their Signature which is whittled down to the
bare minimum to avoid any duplication of the footer details.
From the Mail Format options tab....
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Go into Signature Picker.... Click New... (it's probably better to create a new signature because you
still keep your old signature to use if needed).
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Enter a new name for this short version of your Signature, and select Use this existing signature as a
template, choosing your current signature as the basis for this new one.

Click Next, then select the parts of the signature you want to remove, and delete them…..
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Sidenote: The Advanced Edit... button above normally fires up either Notepad or MS Word
as the advanced editor. Which one is actually used can be changed by starting Internet
Explorer, then going to Tools->Internet Options, select the Programs tab, then for HTML
Editor, select Microsoft Office Word, or Notepad, or another.
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Click Finish. Finally select the short Signature as your new default signature....
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Conclusion
As you can see there are a number of different methods to make email messages appear the way that
you want them, but in order to overcome some of the shortcomings of Microsoft's combination of
HTML email within its own Outlook email software there are a few hoops you have to jump through!
This requires a certain degree of patience, and plenty of testing to ensure that everything works and
appears the way you want it to before you deploy the final solution to other users. Part of your testing
should be to send test emails to yourself, and view the results in other non-Outlook email software
packages, and online email browsers.
We hope that this document has provided you with a better understanding of how to use Stationery
Templates and Signatures in Outlook, and perhaps now you will appreciate why there are not many
professional email template/signature solutions available that allow "letterhead" style email templates.
Signatures with simple sign-off footers are relatively easy to implement in comparison to employing
CSS techniques in Stationery Templates.
This document was originally written and intended for our own customers use, however it became
obvious that other Microsoft product users may benefit from our investigations and ideas.
Unfortunately since this information is provided for free we are unable to provide any support regarding
its content.
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